| IBM Software Group

WebSphere Information Integration

“IBM Information Integration offering on z/OS”

Eric Derbanne — eric.derbanne@fr.ibm.com

[ ETi) M Information Integration Software

4

ON | DEMAND BUSINESS

© 2005 IBM Corporation



Defining Business Integration
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Integration

The efficient and flexible combination of resources
to optimize operations across and beyond the enterprise

4 EC s

. e & T i
People Processes Information
» Portal — personalized information » Workflow management » Federation & data placement (replication,
» Collaboration technology > B2B connectivity ETL, caching)
» Adaptable workplace > Messaging infrastructure (EAI) » XML (store, query, webservices)
~ Consistent rule-based experience across . o_Business transactions » Meta-data management
devices > Service-oriented architecture » Text Search and analytics

40% of people’s time is 40% of IT budgets may 30-50% of design time is | 85% of information is
spent searching for be spent on integration copy management unstructured
relevant information

® for each $1 spent for a packaged application, customers spend $5 to $9 on the labor for integration !
(IBM Customer Surveys, 2001, 2002)

Can | create business value from my existing IT systems? } People, Process, Information
Can users react in real-time to the most recent information? } People, Information

Are business operations fully integrated for optimal efficiency? } Process, Information
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IBM Information Integration Vision
Any Data
» Multiple access paradigms

» Multiple integration disciplines

XQuery Content Search

Federate & Transform | Place Publish

.\~_ __’

Share 1 metadata and accé¢ss foundation

1935

Federated Event
Data Publishing
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Using Websphere Information Integrator as GRID Enabler

= Leverage IT Infrastructure

= Accessing Information Federation
regardless of Database instead of
Management System and i l] Centralization
S t ru Ct u re I m %ﬁmmmmmmmmmmmm

WebSphere Information Integrator

Information Virtualization

s s %

File System / Storage Virtualization §
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Federated Data Server
» WebSphere Information Integrator Classic Federation — z/OS Platforms

> WebSphere Information Integrator - LUW Platforms
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WebSphere Information Integrator Classic Federation for z/OS

= Typical Large IT Enterprise Environment

» Decades of heterogeneous technology investment :
60% of data resides on mainframe and is growing 20% per year

» Real-time access to mainframe—based data to remain competitive

» High performance and scalability are mandatory

= DB2 Information Integrator Classic Federation for z/OS

» Read/Write mainframe data sources using SQL through
standard ODBC, JDBC, CLI

» Native database connectors .. WebSphere Information Integrator
leverage power of each L. (lassc Federation for zIOS
database/file accessed : : -

» Metadata-driven means:

* No mainframe programming
required

- Fastinstallation, configuration pg, ypg  ysama IMSIDLI Software AG  CA CA
& ease of maintenance for z/0S sequential Adabas Datacom IDMS
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WdebSphere Information Integratror (Zas¢ce Federation

Widows NT, 2000, XP, ‘ _
2/0S, 0S/390 | ODBC Client

: Bl Tool Serviet Servlet Client
AlX, HP-UX, Solaris, JVM 1.2, - -

z/0S

0S/390 oy -
Metadata

.| Catalog

Data Data Data Data Data Data
Connector Connector Connector Connector Connector Connector

e

DataMapper
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WebSphere and |l Classic Federation

= Integrate mainframe data directly with
Web applications, Portals, EAI
platforms

= Supports JDBC 2.1 Core APIs Plus
» Scrollable/Updatable ResultSets
» Commit — Rollback — AutoCommit - XA

» Stored Procedure to mainframe
programs

» Parameter Markers

G

_ . ER— - . ’ » Metadata commands for tables,
WebSphere Information Integrator columns, keys, procedures, ...

(lacsic Federation for 2/0S » Connection Pooling Support via

Relational Resource Adapter (RRA)
» SQLBatch Operations

» Statement commands e.g. re-execution
of prepared statements

DB2UDB VSAM & IMS/DLI Software AG CA CA
for z/OS sequential Adabas Datacom IDMS
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Integration in Action — European Catalog House

Seamlessly share order processing data and algorithms between:
» Legacy call-center systems

» New e-commerce applications
» No mainframe skills required for e-commerce site development

Call-Center
Rep

,Customer

|

Customer
Customer

m

Order
Processing

Ship=to
Date'Calc
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Extending Data Warehouses with Real-Time Data

Business Scenario

> Access current customer
records from a call centre

WebSphere Information
Integrator

» Access current stock levels
from a supply chain data mart

» Basel |l compliance

» Business activity monitoring —
linking events to trends
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Integration in Action — Recreation Vehicle Manufacturer

Provide accurate inventory and sales data to data warehouse
» Dynamically connect data warehouse tool with mainframe data

» Cut development time in half

» Accelerate product delivery with warehouse “pull” of new shipment data

v

Order Credit
‘Processin Accurate

= »

Invéntory information 7‘
Management

Sa

A 4

Marketing

Federation
TCP/IP
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Integrating Enterprise Data

, | Integrated SQL View |

DB2 Information Integrator
0 SQL, SQL/XML

DBZ éll : B Federation Engine

Federation
Wrappers and functions

_\

- 1 XM
. .":\:‘ . e
) L

o N 25 i

-
Excel

XML

SAG
Adabas

----
([ [ [

CA :
Datacom

CAlﬁ
IDMS @
Biological Data

4 Packaged \
apps
And Algorithms
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Access Distributed Heterogeneous Data from CICS Applications

Business Scenario

» Access all kinds of DB2 |l CICS/IMS Applications
Data Sources from legacy on z/0OS
Applications Swl

Websphere Information Integrator
Database configured as
DB2 z/OS CDB Location

» Single Site Update, Multi
Site Read

» Distributed UOW with 2PC
support in plan for following
version of WebSphere Il

Distributed Hetero-

geneous Data Sources
are accessed (read/write)
through DB2 Information

Integrator Nicknames I]‘
WebSphere
Information Integrator ORACLE
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Information and Process Integration with WebShpere

Business Scenario

» Enterprise Applications provide
APIs for Business

Object/Component Retrieval SQL, SQL/XML

» Enterprise Business
Components can be mapped
into relational Format using
WebSphere components :

v Information Integration

v Business Adapters

WebSphere

Information; Integrator

WebSphere Wrappers for Integrated
_ ) o Business:Integrator Business Objects
> Business Objects can be joined

with other relational / non-
relational Information

Enterprise Applications
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Federate or Replicate — That is the Question !!

Data Federation

» SQL Transparency
» Real-Time Access
» Global Optimization
» SQL Pushdown

DB2 Federated DB2 and Non-DB2
Database ' Databases

Data Replication

» Data Movement

» Data Transformation
» Autonomy

DB2 and Non-DB2
Databases
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Replicated Data
» SQL Replication
> Q Replication
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Why Replicate?

= Distribution / Consolidation = Availability
» Move data between central to branches, » Scheduled outage, failover,
branches to central, or both disaster recovery
» Federate or Replicate ? » can use Hardware and/or Software
- where does the application need the data ?  * replication offers lower expense,
- does the data need to be real time ? faster restart, multi-purpose
- what is the change volume ? + Hardware offers simplicity of setup

» Move query or reporting work
= Warehouse & Business Intelligence to a separate system

» Move data to new platform/database, ’ gltgsr rc?sesfirt])cl)gs such as flash copy
transform data Y

» ETL or Replicate? » Peer to peer - split workload

. |ar;ien0y neleds ol vol - only possible through replication
change volume versus total volume - requires serious planning

« complexity of transformation and/or and consideration
cleansing

- Mobile Workforce \
» Occasionally connected
distribution/consolidation

I e i ad - ) I |
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SQL Replication Architecture

Staging tables

Aal Implementation

» DB2 Data Propagator
» DB2 Il Replication Edition Nicknames
» IMS/DLI Data Propagator

Log based

Trigger based

External application
= Actual Implementation Benefits

» Extremely flexible and resilient

» Very easy to set up transformations

» Scales well to reach multiple targets

» Homogeneous & Heterogeneous Sources

©) IBrporation 2004 E . iR = * M’matﬁur, Integration - z/OS landscape
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Sample SQL Replication Scenarios

11
E cD
 STAGING  STAGING
Update Anywhere : /\
~ UCOPY  UCOPY
} '
 HISTORY ~ UCOPY  UCOPY
Data Consolidation (n:1) Transformation Multi-Tier Staging

= Subsets = Updateable Predicates
= SQL Transformations = Updateable Primary Keys
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DB2 Data Replication from Federated SOURCES

SOURCE APPLY CONTROL
OURCE2 |
| _SOUR CAPTURE CONTROL
[ uow |

[ AYY . £
. rop Appl

v

ADMINISTRATION

; S — e’
i s
e 3 =y
| 10000 (currently
| T heterogeneous
o T replication with
Replication Replication scﬁ_ Replication TARGET -
Center Monitor only) T

»DB2 » Informix
Federated Sources & Targets >Oracle >Sybase

»SQL/Server >Teradata (Target only)

©IBrporation 2004 F‘ .
A




IBM Software Group | WebSphere Information Integration Software

Why Create Another Replication Architecture?

= Performance

» Combine high Throughput
with low Latency

= New Function

» Event Publishing
from DB2 and Classic Sources

= Capability

» Significantly improve multi-
directional Replication Support

= Manageability

» Reduce the number of
Replication Objects to be defined
and managed

» Ease the Definition Process with
new Replication Center Wizards
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Q Replication Architecture

Websphere Information Integrator introduces new replication architecture
for delivering extremely low latency replication

Ful— Capture

Log based

Procedures

Federation
Engine

WebSphere MQ

= Each message represents a transaction = Data Integrity

» Persistent messaging with
WebsphereMQ

» Detects missing messages

= Highly parallel apply process

» Non dependent transactions
re-parallelized at the target

= Differentiated = Data transformation

conflict detection and resolution » Triggers on the target table
_ » Stored Procedures called by Apply
= Integrated infrastructure at the row level
for replication and publishing » Publish Event to user application

= DB2 to DB2 today

: [L_ | E ﬁ . P )
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Q Replication — Defining Subsets or Filters

= Subset data

» Subset of rows through Q Capture predicate on subscription/publication
» Subset of columns through subscription/publication definition
» Signal (IGNORETRANS) defined to allow user selected transactions to be ignored
» Subscription/publication send options
« Change Only: Publish only columns that have changed vs all columns in the row
- All Changed Rows: Publish a row if any column changes (subscribed or not)
« Suppress Delete: Do not publish row deletes
- Before/After values: Publish before values as well as after values

= Predicate examples

» Based on values in the row data itself
VWHERE : LOCATI ON =' EAST' AND : SALES > 100000

» Based on values in data in other tables

VWHERE : LOCATI ON ="' EAST' AND : SALES > ( SELECT SUM expense)
FROM STORES WHERE st ores. deptno = : DEPTNO)

- L ] Ty
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Sample Q-Replication Scenarios

 PEER1 Key Scenarios:

» Low-Latency
Replication

» Geographically
dispersed Applications
with distributed
Databases

Peer-to-Peer

» Bi-directional
Replication with Conflict

- . Checking, Handling,
. and Notification
<—é{g§— > Software-based Hot-
Standby

» Cross DB2-Family

Bi-directional

©IBrporation 2004 E‘ .
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Feeding Trade-History Database with Q-Replication

High-Speed Q-Replication

|
L]

Trade History
Applications

.

()-Capture

Trading
Applications

rade
Processing Trade

Data History
Business Scenario

» In many Online Environments OLTP Data is kept separately from
Query/History Data for better Performance of both Update and
Query Applications

» This user has just made an Online Trade — he will keep hitting
Enter until he sees that the Trade is complete, in this Case
meaning it has been replicated to the Trade History Database
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High-Availability Solution built upon Q-Replication

_.I Read/Write Applications
—

_'Y_‘!L

W) -Capture

Q Apply

SOURCE _

SOURCE _

SOURCE

Q-Capture ' ' R Apply

Primary Database Secondary Database
Business Scenario

» Replication Processes and Subscriptions are defined in both Directions, but Data
mainly flows in one Direction at a Time

A\

Recursion is stopped by Capture, which reads special logged Events created by Apply

Data at the Secondary System is transactionally consistent and is available for “read
only” Applications permanently

» Procedures for Failover and Switchback will depend on which Options have been
selected for Conflict Detection

A\

© IBrporation 2004 E . . S A ] JBJJJM‘JH;\[ on Integration - z/OS landscape




| IBM Software Group | WebSphere Information Integration Software

Event Publishing




IBM Software Group | WebSphere Information Integration Software

Why Publish Data?

= Database to Application Messaging
» Drive downstream Applications or APIs based on the
Transactional Data of the changed Database Events
= Event Notification
» Stream changed Data Information to Web Interfaces
» Stream only particular Events of Interest (filter Data)

= Data Warehouse / Business Intelligence
» Integrate captured Changed Data with an ETL Tool
» Perform complex Transformations with custom Logic
» Use a specific Transaction Format to update Target

= MQ provides guaranteed delivery
» Avoids the need for 2-Phase-Commit (2PC)
» Works even when the Target is not available

- = o i 0
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Publishing data events to facilitate business integration

Capture database changes as XML messages
and publish them to WebSphere MQ

= Function = Usage
» Publish events to a message queue » Application to application
» XML self-describing format messaging
» Wizard-driven configuration » Event streaming

» Source for ETL tool

/ DB2 UDB
Log-based WebSphere
capture ﬁ Business Integration

IMS/DLI
IDMS

I l WebSphere MQ User
Integrator Broker Application

\ 4

vs AM WebSphere MQ ¥ JMS-aware
A  Application

Classic Data is REACTIVATED !

3 r w . 3
©) IBMsBrporation 2004 E . R . ™ . EJBJ‘JJM’MJ;JE,UL Integration - z/OS landscape




IBM Software Group | WebSphere Information Integration Software

Event Publishing - Publication Options

= Format
» Only data from committed transactions is published
» Data is self describing with XML tags
» Row based = one row per message
» Transaction based = one transaction per message

= Row Content
» Subset by column
» Subset by predicate
» Changed column values only or all column values
» New data values only or include old values

©IBrporation 2004 E .
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Combining SQL and Q Replication with Event Publishing

Log Reader 1

\
!
:
]
;
4
]
4
]

Log Reader 2

:EF

Capture Schema
“CAP1”

Q Capture
Schema
“CAP2”

§
CD2 §
» cD1 » SQL Apply § »I
:
§
|
R S S S A T T S S S A T %

- Staging Tables

Application

SQL Replication and Q Replication can co-exist
» Managed at source by using multiple capture schemas
» One Q Capture can handle both Publications and Subscriptions
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DB2 Il Event Publisher & Business Intelligence

Feeding Changed Data to :
» Data Warehouse

» Datamart

» Operational Data Store (ODS)

Optimize Resource Utilization
» Minimize Bandwidth Requirements
» Maximize Data Currency 91003 100010101011100104001 2001010081 10301 0010100010 0010110170008 0
WebSphere Information:integrator
Event Publishers for:z/OS

Complements with
WebSphere |l Federation

> Data feed using Event Publishers 232 l/JoDsB VSAM  IMS/DLI  CA-IDMS
or z

» Real-time extensions using Federation
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DB2 Il Event Publisher & Business Integration

Data “Events” drive business integration
» Seamless integration with EAI via WebSphere MQ

Wep ﬂ
Service ﬂ

m SEEBEYOND /

Data used to drive EAIl workflow

» Inventory update hits threshold. ..
triggering restocking process

» Addition of new customer:
v’ Initiates welcome email

v’ Credit verification WebSphere SIEBEL.
v Accounting updates v
v
| ”'_)},;‘r' ormatic "_J/:'r
Cross-silo data synchronization WebSphere Information:integrator:

Event Publishers for:z/OS

» Synchronize mainframe updates with:

v CRM %
v' ERP =

v' HR, etc. DB2UDB  VSAM  IMS/DLI  CA-IDMS

©IBrporation 2004 E .
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Sample Application

= Near real-time cross-silo data synchronization
» Loosely coupled integration
» Minimizes development effort
» Simplifies maintenance

u e.g. New order data is automatically pushed to a CRM application
e.g. VSAM employee data updates are pushed to SAP payroll

r

Payroll
Maintenance

Customer

—
Updates

; WebSpf\ere
¥ Business

Integrator
.-.—j
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f v
SOURCE _
SOURCE _

— SOURCE

w8
=vent.Broke
EVenil.bDroKker

Billing Request
Creation

-
S

Q-Capture

e
Entry Order
Applications Processing
Data
Shipping Request
Creation

Business Scenario

» As new Orders are entered into the Order Entry System, the pertinent Data is
captured and published into a Queue

» The Websphere MQ Integrator Broker processes the queued Data

» A billing Transaction is created and queued in one System and a Shipping
Transaction is created and queued in another System

©IBrporation 2004 E . I s, A ;Bmmg&uti on Integration - z/OS landscape
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Sample Application

= Event Notification
» Receivable balances approaching credit limit pushed to a credit analyst
» Threshold is independent of order processing and accounting applications
* No “hard-hooks” in OLTP applications necessary

_____

~

: ReturrEl-l!‘"vs I
\\\ _____ 7/‘/‘ ~ ~‘\‘
[ Order = [
\. Processing .
Orders,
Payments,

Returns, ; —
etc. <7 IﬁtueSIpaet?)Sr ﬁ Jiliy Craellr Al Z
-~ 2Y —

= —

| % Credit
MS Analyst’s
! ? Portal

2
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Why data events versus application events?

= Integration is independent of the source applications

» Applications grow and evolve with
““minimal impact on the integration “

» Relatively straight forward to find data items

“ rather than every business rule “ ﬂ
@
L
pr - TR

» e.g.many applications change inventory 9
but the data values trigger re-stocking

» e.g. many transactions impact Claim status

$ ¥
changes to status value drives workflow m M
» e.g. order data is needed by a CRM
Y

CRM has no dependence on ordering process

g =N g B
B K X - | . nC
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Summary
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Using Classic Il Event Publishing for Replication

m—

IMS/DLI
data is
updated

r
Ll
Data is Captured

near real time

? ﬁ i Stored procedure
g generates DB2

@l | I/U/D statements
N _ \

= |t is our direction to support replication of Classic data sources using the
highly parallel Q Apply of DB2 Il Replication.

= As an interim suggestion, SQL stored procedures can be used to apply the
data captured through the Il Classic Event Publisher
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Summary

= Information integration is a foundation for companies to build an On Demand
Operating Environment enabling them to align their IT infrastructure to
business priorities

= WebSphere Information Integrator provides access to diverse, distributed, and
real-time data as if it were a single source, no matter where it resides.

= WebSphere Information Integrator will help businesses
» Optimize IT investments given more choice in data access
» Improve productivity and application efficiency
» Enable greater return on existing assets

= Rely on IBM’s proven technology and support for open standards

. [ " o | 1
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WebSphere Information Integrator Packaging and PIDs

Distributed (Linux, UNIX, Windows)

WS Il Advanced Ed. Unlimited PID 5724-C74

WS Il Advanced Ed.

WS Il Standard Ed.

WS i
Replication
Ed.

WS Il Event
Publisher Ed.

WS Il Developer Edition
WS Il OmniFind Edition

» Processor-based pricing except for Developer Edition
which is priced by user
* Priced Connectors to access non-IBM sources

PID 5724-C74
(same as for
DB2 II)

Mainframe (IBM eServer zSeries)

WS Il Classic Federation for z/OS
V8.2

DB2 Il DataPropagator for z/0OS
V8.2 (SQL Replication)

WS Il Event Publisher
for DB2 UDB for z/OS V8.2

WS Il Replication for z/OS V8.2
(SQL+Q Replication, Event Publishing)

WS Il Classic Event Publisher
for IMS V8.2

WS Il Classic Event Publisher
for VSAM V8.2

WS Il Classic Event Publisher
for IDMS V8.2

* Value Unit pricing Model

- r w i 4
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PID 5697-182

PID 5655-160

PID 5655-M36

PID 5655-L88

PID 5655-M38

PID 5655-M35

PID 5655-N56




